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Copyright and Disclaimer

The information in this documentation was prepdng@anbolic, Inc. with reasonable care and is belido be accurate.
However, Sanbolic, Inc. shall not assume respdityibor losses or damages resulting from any oiniss, inaccuracies, or
errors contained herein. Sanbolic, Inc. may makgavements or changes in this documentation drérptoduct and
programs described in this documentation, at ang find without notice and as it sees fit. This jgsabibn describes the state
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Please read the terms and conditions of the Agreemiebefore commencing use of the software program.
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End-user License Agreement

IMPORTANT NOTICE TO END-USER . PLEASE READ THE TERMS AND CONDITIONS OF THIS AGEEMENT
CAREFULLY.

THIS SOFTWARE LICENSE AGREEMENT (L AGREEMENT") IS AEGAL AGREEMENT BETWEEN END-USER
AND SANBOLIC, INC. (,SANBOLIC") FOR USE OF THIS SOFVARE, INCLUDING THE ASSOCIATED PRINTED,
ONLINE, OR ELECTRONIC DOCUMENTATION, CD-ROM MEDIACOPY-PROTECTION HARDWARE, AND ANY
AND ALL COPIES OF AND MAINTENANCE RELEASES TO THEGFTWARE, AS WELL AS ANY THIRD-PARTY
SOFTWARE EITHER EMBEDDED IN OR OTHERWISE INCLUDED®PART OF THE SOFTWARE (,SOFTWARE").
BY INSTALLING, COPYING, OR USING THIS SOFTWARE, ENIDSER IS DEEMED TO HAVE ACCEPTED AND
AGREED TO THE FOLLOWING:

1. GRANT OF LICENSE AND LIMITATIONS. In consideration for payment of the applicabletise fees, SANBOLIC
grants to END-USER and END-USER accept a persamahan-exclusive license to use the Software ieabjode format,
including the associated documentation, subjetiteéderms, conditions, and restrictions of thiségnent. END-USER may
install a copy of the Software on a single compotened, leased, or otherwise controlled by END-USERIy for its
internal purposes. If END-USER wishes to make cameu use of the Software on two or more computeR)-USER must
acquire a license for each separate machine. ENBRUSjrees not to modify, adapt, translate, decangisassemble, or
otherwise reverse engineer any portion of the Softwexcept and only to the extent expressly perchliy applicable law.
END-USER may not sell, loan, lease, sublicenséjgiribute the Software, or otherwise create déisieavorks based upon
the software. Prior to disposing of any media cioimg the Software, END-USER agrees to erase aratise destroy any
Software stored on such media. This license doegraot END-USER any right to any enhancementseer versions of the
Software. Any such enhancements or new versioasailable, may be obtained by END-USER at SANBO&IBen current
standard pricing, terms and conditions.

2. OWNERSHIP OF SOFTWARE. All title, rights, and interests in and to the 8afre and underlying intellectual property
rights in the Software are and shall at all timexsain the valuable property of SANBOLIC or its sligns. END-USER
acknowledges that the Software contains valuabtietsecrets or confidential and proprietary infaromeof SANBOLIC, and
that use of the Software does not transfer argyttitlor rights of ownership in the Software to ENSER. END-USER shall
not remove or alter SANBOLIC's or its supplier’spgoight, trademark, or other proprietary noticed &gends included in
the Software. END-USER agrees to take reasonadys $b prevent any unauthorized access, disclodistepution,
possession, alteration, transfer, reproductiomiserof the Software. SANBOLIC and its suppliereres all rights not
expressly granted to END-USER under this AgreemBiE SOFTWARE IS PROTECTED BY INTELLECTUAL
PROPERTY LAWS AND INTERNATIONAL TREATIES. THE SOFTWRE IS LICENSED TO END-USER AND IS NOT
SOLD.

3. BACKUP COPIES. END-USER may make one (1) copy of the Softwaresémurity backup and archival purposes. END-
USER shall place the same copyright and other @@y notices and legends that appear on thelydiggnsed copy of the
Software in any such backup copy.

4. TRANSFERS. SANBOLIC shall have the right to assign its rightgl obligations hereunder in whole or in part. END
USER may permanently transfer all of its rights abtigations under this Agreement to a third-paréysferee provided that
(i) END-USER transfers a validly executed assignnaenl assumption of its rights and obligations wibpect to the
Software; (ii) END-USER does not retain any comitthe Software or prior versions or upgrades, anbments, or updates
to the Software; (iii) END-USER provides SANBOLIGttvnotice in writing of the transfer and the naraddress and contact
person for the transferee; and (iv) the third-padpsferee accepts in writing the terms and camditof this Agreement.
Except as provided for above, END-USER may notsfiemor assign this Agreement or any of its rigitsbligations under
this Agreement without the prior written consenS&NBOLIC, and any such unauthorized transfer dhalhull and void.

5.LIMITATION OF WARRANTIES. Sanbolic warrants that the storage media on wihietSoftware is furnished will be
free from physical defects in materials and workstém under normal use for a period of thirty (3@ysl from the date of
delivery to END-USER, and that such storage melti#l sontain a complete copy of the Software. Ather software and
any hardware furnished with or accompanying thev@&ok is not warranted by Sanbolic. As the safeady for any breach
of the foregoing warranties in this paragraph, ®dintwill replace any and all such defective medith media free from
defects and containing a complete copy of the SoBw

EXCEPT AS STATED ABOVE IN THIS SECTION, THE SOFTWARS (AND ANY SERVICES OR SUPPLEMENTS
NOW OR HEREAFTER PROVIDED WITH RESPECT TO THE SOFARE ARE) PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIEDONCLUDING, BUT NOT LIMITED TO, THE



IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A PARTICULAR
PURPOSE. SANBOLIC AND ITS SUPPLIERS SPECIFICALLYOINOT WARRANT THAT THE FUNCTIONS OR
FEATURES OF THE SOFTWARE WILL MEET ALL OF THE END-8ER’S REQUIREMENTS; WILL OPERATE IN
ALL THE PRODUCT COMBINATIONS WHICH MAY BE SELECTEDFOR USE BY THE END-USER; THAT THE
OPERATION OF THE SOFTWARE WILL BE ERROR-FREE OR IWIERRUPTED; OR THAT ERRORS OR
DEFECTS IN THE SOFTWARE WILL BE CORRECTED. THE ENRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE SOFTWARE (OR ANY SERVICES OR SUEMENTS NOW OR HEREAFTER PROVIDED
WITH RESPECT TO THE SOFTWARE) IS WITH THE END-USERO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, END-USER EXPRESSLY WAIVES ALL WARRANTIES OR CONDITIONS NOT SPECIFICALLY
SET FORTH HEREIN. SOME JURISDICTIONS DO NOT ALLOWHE EXCLUSION OF IMPLIED WARRANTIES
AND CERTAIN OF THE ABOVE EXCLUSIONS MAY NOT APPLY D END-USER. NO AGENT, DISTRIBUTOR, OR
RESELLER IS AUTHORIZED TO MAKE ANY ADDITIONAL WARRANTIES OR MODIFY THE FOREGOING
LIMITED WARRANTY.

6. LIMITATION OF LIABILITY.  IN NO EVENT SHALL SANBOLIC OR ITS SUPPLIERS BE LBLE FOR ANY
SPECIAL, PUNITIVE, INDIRECT, CONSEQUENTAL, OR ANY THER DAMAGES, INCLUDING, BUT NOT

LIMITED TO, LOSS OF PROFITS, LOSS OF REVENUE, LOS% USE, LOSS OF DATA, PROPERTY DAMAGE, OR
ANY OTHER COMMERCIAL OR ECONOMIC LOSS OF ANY KIND RISING OUT OF THIS AGREEMENT, OR THE
USE OR PERFORMANCE OF THE SOFTWARE, OR THE RESUIOBTAINED THROUGH USE OF THE
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SWCDAMAGE, OR FOR ANY CLAIM BROUGHT
AGAINST END-USER BY ANY OTHER PARTY, NOR SHALL SANBLIC OR ITS SUPPLIERS BE LIABLE FOR ANY
DAMAGES WHATSOEVER RESULTING FROM ANY ACT BEYOND I$ REASONABLE CONTROL. TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW. ANY LIA BILITY OF SANBOLIC OR ITS SUPPLIERS
FOR DAMAGES ARISING FROM EITHER THIS AGREEMENT, ORHE END-USER’S USE OR PERFORMANCE OF
THE SOFTWARE, UNDER ANY LEGAL THEORY, WHETHER IN CTRACT, TORT, NEGLIGENCE, STRICT
LIABILITY OR OTHERWISE SHALL BE LIMITED EXCLUSIVELY TO REPLACEMENTOF THE SOFTWARE OR
REIMBURSEMENT OF THE AMOUNT OF THE LICENSE FEES FAABY END-USER FOR THE SOFTWARE, AT
SANBOLIC’S SOLE OPTION. END-USER AGREES THAT THISMITATION OF LIABILITY SHALL ALSO APPLY

TO AND BENEFIT SANBOLIC’'S SUPPLIERS, DISTRIBUTOR®R RESELLERS. SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, INDIFECT, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES, AND THE ABOVE LIMITATION AND EXCLUSION OFLIABILITY MAY NOT APPLY TO END-USER.

7. TERMINATION. Without prejudice to any of its legal rights ardnedies, SANBOLIC may terminate this Agreement if
END-USER fails to comply with the terms and coratig of this Agreement. In the event of any suchiteation, END-
USER shall discontinue all use of the Software, i@tdrn to SANBOLIC all copies of the Software g possession.

8.NOTICE TO U.S. GOVERNMENT USERS. If END-USER is a unit of the United States Goveemty the Software and
associated documentation are provided with restticghts. Use, duplication, or disclosure by thétéd States Government
is subject to the restrictions as set forth in subgraph (c)(1)(ii) of the Rights in Technical Datad Computer Software
clause at DFARS 252.227-7013 or the restriction$osth in (c)(1) and (2) of the Commercial Compus®ftware Restricted
Rights at 48 CFR 52.227-19, as applicable, or atassor provisions, including the limitations setti herein. Manufacturer
is Sanbolic, Inc., 304 Pleasant Street, Watertddagsachusetts, U.S.A.

9. MISCELLANEOUS. SANBOLIC and END-USER further agree that (i) tAigreement shall be constructed in accordance
with and governed by the laws of a Delaware Corpamaapplicable hereto, without regard to its cmtfof law rules; (ii) the
parties expressly exclude the application of th@¢ddnNations Convention on Contracts for the Ind¢ional Sale of Goods,
and any local or international law, conventionregulation which may provide an alternative lavconstruction, to the
extent such waiver shall be permitted by applicédole (iii) if any term of this Agreement is deemeaid and unenforceable,
the remainder of this Agreement shall remain vatid enforceable; (iv) in the event of conflict beém the terms and
conditions of this Agreement and END-USER’ s pusgharder, quotation, or other equivalent, the tesfithis Agreement
shall be controlling. No conflicting term or coridit contained in any purchase order, quotationtleeroequivalent, shall be
binding upon SANBOLIC in any fashion without SANBGZ’s written consent; (v) the parties consent is thgreement
being drawn up in the English language; and (\§ Agreement may not be amended except in a wrékgguted by both
parties.

10.ENFORCEABILITY. END-USER acknowledges that this Agreement is lnigdind shall entitte SANBOLIC to enforce
the above terms. END-USER further agrees that SANBGuppliers referenced in the Software are intehideneficiaries to
this Agreement, and, to the maximum extent perahitig applicable law, may enforce this Agreemerit esdates to their
intellectual property rights.

11.EXPORT RESTRICTIONS. END-USER may not export or re-export the Softwexeept in full compliance with
applicable export controls laws and regulations, amless a validated export license is obtainechfttee applicable regulatory
agencies, as required.



12. ACKNOWLEDGEMENT. END-USER has read, understands, and agrees toupel by the terms and conditions of this
Agreement. IF END-USER IS NOT WILLING TO BE BOUNDYBTHE ABOVE TERMS, THE UNUSED SOFTWARE
MAY BE RETURNED FOR REFUND OF THE LICENSE FEES PAIID SANBOLIC OR THE DISTRIBUTOR OR
RESELLER FROM WHICH END-USER ACQUIRED IT, PROVIDEDHAT THE SOFTWARE IS RETURNED FOR
REFUND WITHIN THIRTY (30) DAYS AFTER DELIVERY. PLEASE CONTACT THE VENDOR FROM WHICH YOU
OBTAINED THE SOFTWARE FOR REFUND AND REFUND INSTRUTONS.

Sanbolic, Inc., 2000. All Rights Reserved.



Installation and Setup of Melio FS

Melio FS is a 64-bit symmetrical cluster file systéhat provides multiple servers with simultaneeesd/write access to data
stored on the same partition or Logical Unit Numti¢yN) on SAN storage.

Minimal System Requirements:

Pentium IV class processor or equivalent

256 MB RAM

11 MB free disk space

LAN (TCP/IP) connection

SVGA - min 800x600, 256 colors

Shared storage connected via Fiber Channel or iSE&bther interfaces are possible as well.

Supported Operating Systems:

Windows Server 2003 x64
Windows Server 2003 R2 x64
Windows Server 2008 x86, x64
Windows Server 2008 R2

Note: Support for Windows Server 2003 x86 and Windowv&e2003 R2 x86 is no longer available.

Recommendations:

Melio FS employs a proprietary communications protgbased on TCP and UDP) for file system manageéme
To ensure that communications between Melio nodesat affected by intermittent network issues, f8éin
stronglyrecommends providing a dedicated network (i.e AMLor switch) for Melio cluster administration tff.
This network should be completely isolated fromrist of the LAN.

Note: Melio FS doesiot support NIC teaming/bonding. Please ensure tlanétwork interface assigned for Melio
cluster administration traffic is not teamed witiother network interface.

To simplify the management of and achieve greageiopmance from your shared storage, Santsbtimngly
recommends using Sanbolic LaScala cluster volumeager to manage Melio shared volumes. Designeshiared
SAN storage, LaScala allows administrators to eréasic partitions, volume sets and stripe setsapgorts
dynamic volume expansion.

Installation Checklist:

Log on to the system in which Melio FS is goindbinstalled using an account with administratisigileges.

Make sure the Windows Management InstrumentatioNl()gervice is running.

Confirm the system has TCP/UDP/IP connectivityn® £ AN.

Install and connect your storage hardware usingristeuctions provided by the respective hardwaamufiacturers.
Make sure the newly installed hardware is operatimgectly. Check the event log for error messagasresolve all
errors prior to installing Melio FS.

Use Sanbolic LaScala, Windows LDM or another volumanager to create a volume that will be formattetth
Melio FS. While it is possible to have multiple Meformatted volumes at the same time, you canpetiy parts of
a volume be used by Melio FS as the formatting ggsavill erase all existing data on the entire nwu

If Melio FS is already installed, please refer he tUpgrading Melio FS guide located under Tech notes on the
following page:http://www.sanbolic.com/support.htm




Installation

After double-clicking on the Melio 2010 setup fike;'Welcome" screen will be displayed:

Setup - Melio F5 == B

Welcome to the Melio FS Setup
Wizard

Thiz will inztall Melio FS on pour computer.

It iz recommended that you close all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

Help |

Cancel

Accept the license agreement:

“ Setup - Melio F5
License
Please read the following important information before cortinuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

End-user License Agreement il

IMPORTANT NOTICE TO END-USER. PLEASE READ THE
TEEMS AND CONDITICNS OF THIS AGREEMENT CAREFULLY.

THI5 SOFTWARE LICENSE AGREEMENT (“AGREEMENT™) IS

A LEGAL AGREEMENT BETIWEEN END-USER AND SANBOLIC,
INC. (“SANBOLIC”) FOR USE OF THIS SOFIWAERE,
INCLUDING THE AS50CIATED FPRINTED, ONLINE, OR ;I

i~ ldo not accept the agreement
Sanbalic kelio FS 2070

< Back Mext = Cancel

Select an installation folder for Melio:

“ Setup - Melio FS

Select Destination Location
Where should Melio FS be installed?

Setup will install Melio FS into the following folder.

To continue, click Next.  you would like to select a different folder, click Browse.

Browse. .. |

At least 14.6 ME of free disk space is reguired.
Sanbolic Melio FS 20710

< Back Mext > Cancel




Select the software components you would like stailt

Note: The option to install Melio FS is grayed out asiiistbe installed in order to use all other components.

“ Setup - Melio FS

Select Components
Which components should be installed?

Select the components you want to install; clear the components you do not want to
install. Click Mext when you are ready to continue.

Full installation

Melio FS

LaScala Volume Manager

- O Remote managemert only
. ® Full package

SILM

AppCluster

FilerScaler

Cument selection requires at least 14.1 MB of disk space.
5 anbalic kelio FS 20710

< Back Mext = Cancel

Select an IP address (network interface) for Melister administration traffic:

“ Setup - Melio F5
Network configuration
Melio F5S uses TCP/IP protocol to connect to ather cluster nodes. Usage of a
separate network adapter for Melio FS private traffic is recommended

To continue with the installation please select the network connection that Melio FS will
use

O 1921680210

[©310.0.0.10

Sanbalic Melio FS 2009
< Back Next > Cancel |

If you have Windows Firewall enabled and runnirg installation automatically asks you to add T@GE &@DP port 7777 in
the port exceptions of the firewall:

“. Setup - Melio F5

Configure Windows Firewall

Sanbolic Melio BS 2010
= Back Mext = Cancel




If you later decide to change the IP/port pair k&edg; Melio FS will automatically reconfigure Winds Firewall to
accommodate for the new settings. If you are uaitigrd party firewall, you'll need to configureritanually or the servers
will be unable to communicate with one other, whigh lead to their inability to form a functionaluster.

Select the user account that LaScala volume mandfjerse to manage Melio FS shared volumes:

S

Select LaScala Machine User Account
Enter LaScala Machine User Account to identify this computer

LaScala Machine User Account Mame must be in the form "myserver'usemame" for a
local computer account) or "mydomain*usemame” for a domain account). This must be
a valid existing account.

Machine Account name:

ISer\rer‘I\Administl—cltor

Fassword:

Sanbalic WMelio FS 2000

< Back Nexd > Cancel

Select the user account that SILM will use to penfdata mover operations:

“ Setup - Melio FS

Select SILM Service User Account
Enter Service User Account to be used by the SILM service

Service User Account Name must be in the form “myserveriusemame” for a local
computer account) or "'mydomain‘usemame” for a domain account). This must be an
existing account and a member of the Administrators group for this machine.

Service account name:

ISer\reﬂ\ﬁdministmtor

Password:

Sanbaolic belio FS 200 0

< Back Next = Cancel

Click “Install” to install the selected components:

“ Setup - Melio F5

Ready to Install
Setup is now ready to begin instaling Melio FS on your computer.

Click Install to continue with the installation. or click Back if you want to review or
change any settings.

Destination location:
C:\Program Files'Sanbolic

| v

Setup type:
Full installation

Selected components:
Melio FS
LaScala Volume Manager
Full package
SILM

AppCluster fo

FilerScaler hd
| »

Sanbolic Melio FS 2070
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Select the user account that AppCluster will useémage application clusters:

iip Setup - Sanbolic AppCluster

Select Service User Account
Enter Service User Account to be used by the Sanbolic AppCluster service

Service User Accourt Name must be in the form “myserver'usemame” for a local
computer account) or "mydomain*usemame” for a domain account). This must be an
existing account and a member of the Domain Admins group.

Service account name:

IDornain1\Administm10r

Password:

Help < Back Nexd > Cancel

Select the location to store the AppCluster comfigion files:

fiss Setup - Sanbolic AppCluster

Path te configuration files
Configure Sanbolic AppCluster

Select the folder on the shared storage where the AppCluster configuration files reside.

The AppCluster corfiguration folder:
IF‘:\.NJpC]uster

Help < Back Neat > Cancel

Select the resources you want managed by AppCiuster

I'Ea Setup - Sanbolic AppCluster

Resources to cluster
Configure Sanbolic AppCluster

Select which resources will be managed by AppCluster:

I¥ ficrosoft SGL Server 2005/2008
¥ Microsoft IS Web Services

I Microsoft IIS FTP Services

¥ Microsoft Hyper-V Server

Help < Back Neat = Cancel

11



Depending on the resources selected, the usebevfrompted to configure the resources managedopAuster.

For example: If SQL Server is selected, the follogwvindow will be displayed:

'3’ Setup - Sanbolic AppCluster

Configure 5Ql Server Instances
Configure Sanbolic AppCluster

Enter the names of the SAL Server instances you want to manage, separated by
commas, ex: SQL_SANT.5QL_SANZ

SQL Server Instances
|SQLEXPRESS

< Back Mext > Cancsl

Enter the names of the SQL Server instances you AgpCluster to manage.

The installer will then ask the user to selectwloekload level for this server:

lza Setup - Sanbolic AppCluster

Configure machine load in the cluster
Corfigure Sanbolic AppCluster

Select the workdoad level for this server.

Mote: A higher number instructs AppCluster to impose a higher load level on the server.
The default value of "100" should be well-suited for most cluster scenarios.

Machine weight {range: 1 — 10000):
100

< Back Mext = Cancel

Click “Install” to proceed with the installation éfppCluster:

I'Ea Setup - Sanbolic AppCluster

Ready to Install
Setup is now ready to begin installing Sanbolic AppCluster on your computer.

Click: Install to continue with the installation, or click Back if you want to review or
change any settings.

Destination location: ;I
C:\Program Files"Sanbolic’\AppCluster

Start Menu folder:
Sanbolic

12



The next step is to select “Trial” or “Full” mode:

% Setup - Melio FS

Personal Information
How will you use Melio FS7

Please specify how you would like to use Melio FS, then click Mext.

" Full version

S anbalic elio FS 2003

Help | Nexdt >

Running Melio FS in “Full” mode requires enteririgetserial number received when Melio FS was puethdsis important
to register all Melio instances using unique lieekesys (i.e., one license key per Melio node) ®ues they form a cluster.

In “Trial” mode Melio FS has no functional limitatis — all features are supported. However trialeriedime-limited and
expires 14 days after a volume is formatted, attvhime, the volume transitions taead-only state. All data remains intact
(i.e., nothing is destroyed), but you will not H#eato store any new files on the volume. Once MEN is upgraded to “Full”
mode, the write protection is removed and datactene again be written to the volume.

After the setup is completed, the Melio FS kernmalet will start running. Installed components wiltlude the "Melio FS
Configuration” graphical user interface tool, sew@ommand line utilities and other internally usednponents.

jtelb

Completing the Melio FS Setup
Wizard

Setup has finished installing Melio FS on your computer.

Click Finish to exit Setup.

¥ Start Melio FS Configuration Tool:

< Back I Finish I

Click “Finish” to close the Setup program.
Repeat the installation process on all machineswfilashare access to Melio volumes.

Once Melio FS is installed on all machines, prodeetthe next section to create your shared storage.
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Formatting a volume with Melio FS

To use Melio FS, format a new volume with Melio B&fore doing so, ensure that the volume has & dietter assigned and
is displayed in Windows Explorer. Assigning a drigtter is achieved through Windows diskmgmt.msoaggment console.
Make sure the volume has been assigned to allrsemvening Melio FS that will need to share acdess

To format a partition with Melio FS, right-click dhe appropriate drive letter in Windows Exploradaelect "Melio

Format". Please note that formatting via the Wins@antext-sensitive (right-click) menu must be perfed fromone
machine only, after which all servers running Md#i® will automatically discover and mount the sdarelume.

A confirmation message will be displayed:

Melio Format
Farmatting |: [Wolumelc573dd43-64fa-11de-bdb3-306e6f56963}
b with MelioFs.

WARMIMG: Formatting will erase ALL data on this dizsk!
Do you want ta continue?

Click “Yes” to format the volume with Melio FS.

Formatting a newly created volume with Melio FSalgutakes several minutes to complete. If the m@dus already
formatted with Melio FS and there are other machexxessing the volume, the reformat operationfailland an error
message will be displayed. To format the volumes yeed to ensure it is not in use by other seraedsthere are no open
handles referencing it.

Note: Formatting a volume that was previously formatigith a file system other than Melio FSnet recommended as it
could lead to volume performance or stability issue the event that a previously formatted volumest be used, it is
imperative that all other machines accessing thenve be disconnected from the storage or shut déa.reason is that
NTFS is not SAN-aware and since other machines haweay of knowing that this particular NTFS voluimees disappeared,
Windows may still attempt to write data to the waky which could lead to data corruption. Thuss gtiongly advised that
only new, raw volumes be formatted with Melio FS.

Specifics of operation with Windows 2003/2008 dynam  ic volumes

The only way to create a new software RAID volum&\indows Server 2003/2008 is to utilize “dynamigkg” that are
managed by Windows Logical Disk Management (LDMxhaugh Melio FS supports volume sets and all Wimslsoftware
RAID levels, since LDM is not SAN-aware, which cduéad to complications, Sanbolic recommends mauggigfielio FS
shared volumes with Sanbolic’s LaScala cluster malumanager. Using LaScala, users can obtain trenadd functionality
afforded by “dynamic disks” using basic disks.
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If LDM is going to be used, it is important to foll the procedure described below when using dynaolianes on multiple
machines connected to shared storage:

Turn off all servers except one.

From this machine create the appropriate dynansksdand storage volumes (RAID 0, 1, 5, volume sets)
Now you can safely format them with Melio FS.

Turn on a second machine and enter Disk Managembatdynamic disks will be displayed as foreign.
When you import them, they will be automaticallgognized by LDM and Melio FS.

5. Turn on the other machines one by one and repeatport via Disk Management.

PowbdE

Please note that you musit launch Disk Management after the above stepsampleted r LDM will mark the dynamic
disks as “offline,” disrupting normal Melio operaiis. You should only start Disk Management on #s¢ tnachine connected
to the shared storage.

Using Sanbolic LaScala cluster volume manager imjuwtion with Melio FS, dynamic disks are not riggqd. Since both
applications are designed for shared SAN stordgeiretions, including more advanced functionstsas dynamic volume
expansion, can be performed using “basic disksis Tteans there is no need to convert disks to “aynaisks” to achieve
advanced functionality when LaScala is used to mearshared volumes formatted with Melio FS.

Usage

Melio FS is a shared file system that supportstalhdard file system operations such as creatopyicg, moving, renaming
and deleting files and directories, reading frord amiting to files, changing file and directoryrétutes, locking whole files

or particular sections only, etc. Since Melio F& shared file system, all of the above operatoamsbe safely performed on a
volume by multiple machines simultaneously.

There is no user interface at the core of MeliolESfunctionality is accessed indirectly througlindbws Explorer and all
user applications using operating system commanets &s "copy" or "dir" or via the standard Win3agnamming functions
such as CreateFile(). Melio FS is tightly integdatgth Windows 2003/2008 server operating systentssaupports all
commands and system API functions transparentlysm application that works with NTFS will alsonkavith Melio FS.

Melio FS is a fully-journaled file system, which ames that all metadata changes are recorded inceabpeea on the disk
called a journal (aka a log). If a machine crashegxample, the file system may be left in a nonsistent state, potentially
leading to data corruption. To prevent this, akimupted operations are checked and replayed tistngurnal. This is
performed upon first volume access by one of tte@lave nodes in the cluster (not necessarily thshed node). It is
important to note that the process of replayinguarjal can take some time and delays can be expentier these
circumstances.

Performing additional tuning
There are additional parameters you can configutee Melio FS Configuration graphical interface.

Note: Default values are designed to work under the ritgjof configurations. As such, modifications madeany of the
parameters described below shootd be made without first conferring with Sanbolic fieical Support.

Specifying TCP/IP communications settings

During installation you will be asked for a TCP pand IP address used for communication betweeioMedtances on
different machines. An IP address must be seléEsedomputer has more than one valid IP addreser@ise you can leave
the value at the "Default IP" setting. (See diagamiollowing page.)

Note: Sanbolicstronglyrecommends the use of a standalone network ifothe of a VLAN or hardware switch for Melio FS
cluster administration traffic. Using a networkttigseparate from the rest of your LAN will minireithe potential for
network issues such as congestion to adverselgtd¥felio communications, ensuring optimal performaat all times.

Note: Melio FS doesiot support NIC teaming/bonding. Please ensure tandtwork interface assigned for Melio cluster
administration traffic is not teamed with anothetwork interface.
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Fine Tuning Melio FS

Disk Flush Disabled- Setting this option may help in situations whieaedware issues exist. Certain disk storage does n
support this command or support it effectively @lsuwhen the command is issued it takes a loinoé tto be completed by
the underlying storage). When checked, Melio F$wat issue disk flush commands. If unsure, leavehecked.

Pre-allocation Disabled -Setting this option isot recommended unless advised by a Sanbolic suppgirteer.

Modifying cluster-wide times

These times affect the operation of all machingténcluster. The parameters are volume-specificcence changed, are
written to the respective volume and propagateolitinout the entire cluster.

Note: Cluster Times values are written directly on tbéume, which requires that the volume be lockedpenarily by one
machine. This will make the respective volume imasible to all other machines in the cluster fehart time while the
changes are written. Also, you must ensure ther@aropen files and/or handles for this volumetendther machines, as this
will prevent the volume from being locked. If thenee any open files and/or handles for the voluimemessage "Failed to

lock volume. Access is denied." will be displayed.

Note all times are in milliseconds:
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Max IO Time - This is the maximum time an operation to or fritra shared disk can last.
Heartbeat Period - This is the time interval at which the heartbefzck is invoked.

Max Net Roundtrip - This is the maximum time in which a machine etpeo receive an answer from the other computers i
the cluster to its request over the TCP/IP network.

Max OS Response Delay The interval between the expected start of gegy®peration in the computer and its real start.
Unless the computer is under constant 100% logly#iue should not be changed.

Min Crash Recovery Delay -This is the minimum time it takes for the clusteidetermine that a machine is not responding
and evict it from the cluster. While this proceskets place, I/O operations may be disrupted, dépgrmh the file system’s
read/write pattern. This is because machines nefigtin from changing data on the disk in orderniswge its integrity. This
delay depends on all the preceding parameteraniiat be directly changed and is calculated basdteoother values.

Clicking on the Reload' button rereads the volume values. After applyimg changes to a volume, press the Reload button to
make sure you see the most recent numbers.

Viewing/modifying registration details

Using the registration window (see screen below) gan upgrade Melio FS from “Trial” to “Full” modeapply new Melio
license or check supported features.

Transitioning from “Trial” to “Full” mode takes pt@ on the fly. Simply enter the user name, compemye and serial
number and click “Apply.” Please note that ihist possible to form a cluster that includes nodesgudifferent license types.
If you have a cluster of licensed Melio nodes, @mige running in “Trial” mode will not be able toifp the cluster (and vice
versa). In such situations, an appropriate messagstten in the System event log.

Per Process Tweaks

There are a number of settings that affect the avagocess behaves.
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Report fs as NTFS -Specifying a value other than zero enables thitngetwhich some applications may require in orer
work properly with Melio FS.

Disable Access Time Update Specifying a value other than zero enabless#igng, which suppresses the "Date accessed"
property of files. With this parameter enabledigmificant increase in performance may be obsewken working with files
and/or directories, i.e., viewing directory contemeading files, opening multiple files, etc.

Disable Cache Back Specifying a value other than zero enables thtsgetwhich may result in increased performance for
some applications.

Warning: This parameter shouldnly be enabled when instructed by Sanbolic techniggpert!!! Enabling this parameter on
your own accord may present undue risk.

Block application access Specifying a value other than zero enables thimgepreventing the specified application from
accessing the file system.

Ignore Write Through - Specifying a value other than zero enablesstiing, causing the file system to ignore the
FILE_FLAG_WRITE_THROUGH.

Warning: This parameter shouldnly be enabled when instructed by Sanbolic technigapert!!! Enabling this parameter on
your own accord may present undue risk.

Ignore No Buffering - Specifying a value other than zero enables thitngetausing the file system to ignore the
FILE_FLAG_NO_BUFFERING.

Warning: This parameter shouldnly be enabled when instructed by Sanbolic technigapert!!! Enabling this parameter on
your own accord may present undue risk.

Enforce Write Through - Specifying a value other than zero enabless#iing, which enforces the
FILE_FLAG_WRITE_THROUGH. This setting may fix flugations in the performance of certain applicatidses, video
applications.

Warning: This parameter shouldnly be enabled when instructed by Sanbolic technigapert!!! Enabling this parameter on
your own accord may present undue risk.

Enforce No Buffering - Specifying a value other than zero enables thitngetvhich enforces the
FILE_FLAG_NO_BUFFERING. This setting may fix fluations in the performance of certain applicatioms, video
applications.

Warning: This parameter shouldnly be enabled when instructed by Sanbolic techniggpert!!! Enabling this parameter on
your own accord may present undue risk.

Dirty Page Threshold —Specifying an integer value informs the systemhefthreshold for dirty pages within the system’s
cache before they are flushed. For example, iktlee multiple files opened by the specified prectss setting will affect
the dirty pages of each file. The default valu@,isdicating that there is no threshold. Thisiegtis on a per file basis.
Warning: This parameter shouldnly be enabled when instructed by Sanbolic techniggpert!!! Enabling this parameter on
your own accord may present undue risk.

The settings that correspond to the [Default] psscae global settings* - they affect all procesEesprocess is added, its
settings will override the global ones.

You can add a process by right-clicking in the Bezcpane. This will allow you to browse for the@xnable file. To add the
preferred settings, you must select the desiredgsofirst and then right-click in the "Tweaks fioocess" window pane. You
will notice that the relevant process is displagéér "Tweaks for process".

Note: It is not recommended to change global settisigge this may lead to unexpected behavior ofithesystem. Instead,
changes should be made on a per process basis.

Per Volume tweaks

These tweaks manage the behavior on a per volusig. Gdese can be set globally for all Melio volsnhg using them on
the [Default] placeholder or individually for eagblume available. There are two per volume tweaks.

The first one commands the Quality of Service /Q@8/use the QoS tweak first select the appropriateme, then
right click in the "Tweak Name" column and chooseld Enable QoS". This will add a value of 1 (endbi® the
tweak. A default Melio installation doesn’t have ®enabled.

The second tweak commands the Level 1 batch opldfcksu enable this tweak by specifying a valueestthan
zero, Level 1 batch oplocks will be disabled periblume specified or as a default.
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Quality of Service
To use this feature, please enable it as deschild#er Volume Tweaks.” QoS allows a user to assigpecific amount of the

total throughput available in a storage contrdiieone or more processes running on a machine aokéoor more VHDs.
Priorities are managed by a point system startiitig thie lowest priority (1) and ending with the hest priority (1000).

You can add a process by right-clicking in the Bescwindow pane, which will allow you to browse floe executable file.
To add the preferred settings right-click, selept@ess and edit the “Points” column by entermgdesired value.

The following is an example illustrating the useQWS:

There are two processes — A and B, both of whiethandwidth intensive, and two other processesardD, which do not
require as much bandwidth. Here is a scheme gbtbeesses points:

A —10 points

B — 10 points
[Default] — 5 points
C -1 point

D — 1 point

Based on the above described point scheme, wiiteBsoA and Process C running at the same timeah@viadth will be
redistributed between them as follows: Process Ihhaive 9/10 (90%) of the bandwidth reserved, wRitecess C will have
only 1/10 (10%) of the bandwidth.

QoS by Filename works in conjunction with the peygess scheme described above. Points assignddefile group/folder
are added to the ones for the process and themidthdeservations are calculated as above. Ifagilds are used to
generalize particular types of files, the proces®asing them will get points added for all of thesra whole. Of course QoS
can be set on a file by file basis by assigninggisi to individual files, not groups.

It is important to note that every process parétifg in QoS computation has points assigned eegkplicitly set or using
the default.
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Supported features in the registered version
You can obtain a registered version of Melio FShvpiartial or all features enabled. Melio FS offéaes following features:

Number of machines allowed simultaneous access tovalume— You may buy licenses which allow up to 5 machitzes
have simultaneous access to a volume or you maysehm have unlimited number of machines.

Modify security — With this feature enabled, you will be able todify the files and directories security.

Extend volumes— This feature allows you to extend volumes fotawtvith Melio FS. Note that the volume manager
application that you are using must support volextension.

Reparse points— Enabling this feature will allow a user to malee of the reparse points’ functionality.
Sparse files— These are files that are mostly empty, enabliigjfeature allows you to use software that regusgarse files.

Modify cluster affinity — Cluster Affinity allows a specific cluster nodar group of cluster nodes) to keep the connectiaan t
shared volume after it has lost communications withremaining cluster nodes.

QoS- This is Melio FS quality of service feature tehares bandwidth between applications accessingptie volume, QoS
can be set on both process and file/class of idesss.

Extended file attributes—a file system feature that allows users to astociamputer files with
metadata not interpreted by the file system. Tédgure enables NTFS compatible extended file ateggon Melio FS.

Open file by ID — File ID is a 64bit reference number for a filliiSnumber is assigned by and specific to a pdatidile
system. An application can use a file_id to opendtrresponding file.

Windows folder and file sharing— This feature allows sharing Melio FS files ancediories on the network.

Volume shadow copy (Snapshot} The snapshot capability allows fully-journale@gshots to be created from any server in
the cluster. The snapshot capability supports stahéPIs and can be invoked by industry standar8 Y¥&ckup software.

Command line utilities:

set_cluster_affinity.exe*— This utility is located in the Melio FS instdltan folder C:\ Program Files\Sanbolic\Melio F®ly
default) and is used for cluster affinity featudsranistration. Weights can be assigned on the ddei® volume from
different servers. By default all volumes on altlee have a cluster weight of 1, making them edura. syntax is as follows:

set_cluster_affinity.exe \\.\x: <weight> or
set_cluster_affinity.exe \?\Volume{dab8cf5f-eedd2-935e-0011d89ce0al} <weight>

In case of TCP/IP network connection loss betwesnesof the nodes, the cluster can split into sévsotated smaller
clusters attempting to access the shared volumemally this can lead to a split-brain situationathich different cluster
groups think they own the same volume exclusiwelyich can result in data corruption. To prevens gituation from
occurring, fencing mechanisms are used to dismihentolume on misbehaving nodes. When clusterigffis set, weights
are summed up and the heaviest cluster (highedtveight value) becomes the current owner of tileme, with all
remaining nodes removed. For example, if you ssght for a particular volume greater than the nends cluster members
on one of the machines and then deliberately dighgpnetwork connection between them (i.e., chanthe Melio
TCP/UDP port number), all but the heaviest one ledve the cluster.

Note: Cluster affinity is available witMelio EnterpriseandMelio Datacentereditions only and will return an "Incorrect
function" error message wittielio ProfessionalandMelio Virtualization editions.

vss_client.exe* This utility is located in the Melio FS instaltat folder (C:\ Program Files\Sanbolic\Melio FSy default)
and allows the manipulation of the cluster wide iIM&®ISS compatible snapshots. Below is a list ofpguwfed commands:

Create Shadow - create a new volume shadpw co

Delete Shadows - delete volume shadow copies

Delete ShadowSet - delete an empty shadow set

List Shadows - list existing volume shadmpies

List Providers - list registered volume @b copy providers
List Volumes - list volumes eligible fdnadow copies
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Expose Shadow - expose the shadow copy agarenount point or a network share
Unexpose Shadow - remove an exposed shadow copy

The syntax is very similar to the default vssadividlume Shadow Copy Service administrative commamel4ool included
in all Windows operating systems supporting VSS.d&@mple, to create a volume shadow copy of adviedl volume:

C:\Program Files\Sanbolic\Melio FS>vss_client.eseate shadow /for=X:

Melio FS Volume Snapshots management tool.

Successfully created shadow copy for 'X:'

Shadow Copy ID: {ae24550c-446e-4f60-b8e8-634d1168¢5

Shadow Copy Volume Name: WW\GLOBALROOT\Device\Mok{ae24550c-446e-4f60-b8e8-634d1ff3c56b}

Then the shadow copy can be deleted, exposedetsvark share, etc.

Note: There is also a GUI application that can manadene shadow copies provided with the default Mél#®installation.

Sanbolic VSS GUI tool:

Melio FS includes an easy-to-use graphical uttligt makes working with Melio VSS Snapshots simftleacludes the ability
to create/delete snapshots and mount/dismount ¢exploem as a network share, thereby allowingehd pnly point in time
copy of the whole volume to be accessed via thedatal Windows file and folder sharing feature.

Each action has a corresponding event in the “Mgssasection in the bottom-right window pane of ifiterface, showing
the operation status returned — success or a plartierror message code.

Troubleshooting
This section includes several steps that can Herpsed if issues arise when using Melio FS shatexhge.

First, make sure that your storage hardware is iwgrroperly. Check the system and application elanfor error
messages. If there are timeouts, controller oradegirors, or something else, fix them accordingoir storage
manufacturer’'s guidelines.

Confirm that all machines participating in a clusiee running in the same mode (trial or full)tHé machines are
running in full mode, ensure that each machinesisgia unique license key for the same edition efidFS —
Virtualization ProfessionalEnterprise or DatacenteiMixing different editions in the same clustenist supported.
To check which mode and edition of Melio FS is riaign go to Start > Melio Configuration > Help > About
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Ensure there is network connectivity between alMelio nodes in the cluster. This is especiallpantant on multi-
homed systems (systems with several IP addreddek sure Melio uses the correct IP addresseseoméithines,
so Melio instances can communicate across the metso ensure that all Melio nodes are set tosthime port
number (this applies to both TCP and UDP).

Check the Event log for messages generated by M&lidrhe file system reports information, warning &rror
messages in the System log that can offer ideasdeg how to proceed with troubleshooting (i.@inting to a
connectivity issue, disk array problem etc.).

Check the version of Melio FS being using by chegkhe information shown via Help->About in the MdFS
Configuration tool. This will help you determineyibu need to download an update for Melio FS.

If you experience any anomalies, you can comparn@NS with NTFS by running the same operation@nMNTFS
volume. If both file systems behave the same, thisnis the intended behavior and is not indicatf/a problem.

How to request technical support

The email address to contact technical supp@tjport@sanbolic.comWhen you submit a support request, please follow
these guidelines:

. Supply information on your hardware and software
. Supply the exact Melio FS version.

. Describe the steps to reproduce the problem.

. Supply event logs from all cluster nodes.

. Supply the exact error message.

. Specify how many times the problem occurred.

. State the actual results.

. Outline the expected results.

o~NO O WNE

1. Supply information on your hardware and software

Use the All programs-> Accessories-> System toolsyste®n information or other product that will givetdils about the
software and hardware being run on the system.

Please describe the configuration of your centrabge. Specify the type and speed of the connettithe hosts, the type of
the disk array - JBOD or RAID, the model of thedhdisks. Also describe the RAID controller, the BAgevel, type of RAID

(hardware/software), what software achieves theDRshctionality (Windows or third-party). Descriltiee topology of your
storage network (how many hosts, how many diskyarfaow many loops, etc.).

2. Supply Melio FS version

The version of Melio FS can be obtained by usimrg¥telio configuration tool. Launch the tool, sel&am the menu Help-
>About and write down the driver information at thettom of the message box.

Please make sure that you run the same versioretd S on all your machines. If for some reasas ihnot the case, please
state the version of Melio FS on each of the mazhin

3. Describe the steps to reproduce the problem

Please write down the exact steps that had letigetparticular problem. If we can't reproduce eébfgm, we will hardly be
able to identify, investigate and fix it.

Due to the distributed nature of Melio FS you wgive to include some additional information as widlke notes of the order

in which machines were started - this directly esponds to the order they enter the cluster andadfiscts some other aspects
of Melio operation.

4. Supply event logs
Please send system and application event logs dtbyour systems forming a cluster. Melio FS writissinformation in the

System event log, but other software (e.g. MS S€lters important information in the Application etég. The event logs
should be in native binary format (not as textsfileTo do so, perform the following steps:
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Launch Event viewer (Start menu -> Run... -> typeetgvwr" without the quotes)

Select System Log, from the ‘Action’ menu selecav8 Log File as...” Make sure the type of the filé'Event Log
(*.evt(x))".

Choose "Event Log (*.evt(x))" type of the log whéaving.

To further help Sanbolic support get as much infiiiam as possible out of log files, it is helpfaldtate the approximate time
the issue occurred.

5. Supply the exact error message

If an error message is displayed in a messagevirite, down the exact text of the message. Pleasslate the text into
English, if the message is in some other languaAlp®. you may perform a screen capture of the emessage as follows:

1. Make sure that the error message is the aciivéow. Press Alt+PrtScn to place a bitmap copy efittndow in the
Clipboard.

2. Open the built-in MS Paint bitmap editor, andtpahe image.

3. Then go to "File->Save as" and choose a filename

In case a STOP error occurs that leads to a "loeer of death”, it is important to obtain the leémemory dump that should
be created at %SystemDrive%:\Windows\Memory.dmpolf have made some analysis or suspect it maydbie HS

related, please compress and upload it via therfdaager in your accountlaitp://clients.sanbolic.conThen contact
support@sanbolic.comvith a problem description according to the stephis section, we’ll analyze the dump and advise
according to our findings.

6. Specify how many times the problem occurred

The best property a problem may have is to be demible every time a particular test is run. Unfiogtely this is not always
the case, if a something shows up only once chaareeis won't be discovered.

Please specify the frequency with which a particblag is occurring - every time you use the samapsstintermittent (how
many times in how many tests), just once.

7. State the actual results

Describe the exact results achieved during theugsg quantitative values, when possible. For gtanavoid saying just
"the machine hangs". Instead say something aloagjribs of "Windows Explorer stopped respondingn(ead), we waited for
X minutes, nothing changed, we had to kill the exgd process".

8. Outline the expected results

Please describe in detail the expected test results

Contacting Sanbolic

Sanbolic Inc.

Support contactsupport@sanbolic.com
Information requestsnfo@sanbolic.com
Sales inquiriessales@sanbolic.com
Web site:.www.sanbolic.com

Mailing address:
Sanbolic, Inc.

304 Pleasant Street
Watertown, MA 02472
USA
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